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Downloading Exercise Files 

Exercise files can be downloaded from the Cheryl Price web site as follows: 
 

  

 

1 In your web browser, type: www.cherylprice.co.nz 

2 Press Enter on the keyboard to display the Cheryl Price website. 

3 
Click in the Product Search box and type the number of this unit 
standard, as shown at the right. 

4 Click on     

5 Click on   

6 

Under the Exercise Files heading click on the underlined blue hyperlink, ie     

Book Exercise Files – V7 Excel 2010  Free Download 

The File Download dialog box will display.   

7 If you have Winzip use the following instructions otherwise move to step 8. 

 a   Click on  .    

 
b   Click on the  of the  button. 

 c  If My Documents folder is not displayed click on Set default unzip folder at the bottom 
of the list.  Ensure My Documents is selected then click on Select Folder. 

 d    Click on the  of the  button and click on the My Documents folder.  The files will 
be unzipped. 

8 Click on and ensure My Documents folder is displayed.  Click on  

9 
Click on Open Folder which will display My Documents folder.  Right click on the zipped 
exercise file and select Extract All. Click on Extract.  A folder will be created containing the 
exercise files.   

US 2785 

US 2785 
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Unit Standard 2785 Version 7 
 
Title Create a computer spreadsheet to provide a solution for organisation 

use 

Level 3 Credits 5 

 

Purpose People credited with this unit standard are able to plan and 
create a spreadsheet to provide a solution for organisation use, 
and create end-user documentation for the spreadsheet. 

 

Classification Computing > Generic Computing 

 

Available grade Achieved 

 

Entry information 

Recommended skills 
and knowledge 

Unit 2784, Create and use a computer spreadsheet to solve a 
problem, or demonstrate equivalent knowledge and skills. 

 
 
Explanatory notes 
 
1 Candidates are required to design and produce a spreadsheet that is suitable for 

an organisation to use within its everyday business.  The spreadsheet can be 
created as part of a candidate's work or in response to a scenario provided to, or 
created by, the candidate.  More than one active spreadsheet must be produced 
for the purposes of this assessment and each of these must contain macros.  
Each spreadsheet must also be graphed. 

 
2 A plan outlines a list of steps of how the requirements of the spreadsheet will be 

realised.  The plan must include the specifications and/or features required by 
the spreadsheet to provide the solution.  The plan may be modified during the 
task and changes justified.  Evidence of planning may be oral, written, and/or 
graphic. 

 Depending on the assessment context, the plan may include: 
 key milestone outcomes; 
 how resources such as time, expertise and materials (and finance, if 

appropriate) will be used to achieve the outcomes of each milestone; 
 how consultation with stakeholders will be carried out to ensure that all 

constraints and requirements are met. 
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3 Definitions 
 Organisation describes the context the spreadsheet is designed to operate in 

(eg businesses, clubs, and not-for-profit organisations).  It does not define or 
limit the situations in which assessment evidence may be gathered. 

 A simple end-user document includes a short description of the purpose of the 
spreadsheet, how to access the spreadsheet template(s), and instructions for 
the spreadsheet’s use.  The end-user document must use consistent font and 
layout, be legible, and should either avoid the use of undefined jargon or 
acronyms, or provide a glossary for these.  The document must be saved in a 
format that is accessible to users. 

 
4 Legislation relevant to this unit standard includes but is not limited to the: 
 Health and Safety in Employment Act 1992, 
 Copyright Act 1994, 
 and their subsequent amendments. 
 
5 An assessment resource to support computing unit standards (levels 1 to 4) can 

be found on the NZQA website at http://www.nzqa.govt.nz/for-
providers/resources/index.html. 

 
 
Outcomes and evidence requirements 
 
Outcome 1 
 
Plan a computer spreadsheet to provide a solution for organisation use. 
 
Evidence requirements 
 
1.1 The plan identifies the requirements of the spreadsheet in terms of its 

purpose and target users. 
 
1.2 The plan outlines the specifications and requirements, including constraints 

and/or features to be met by the spreadsheet for it to provide a solution. 
 

Range includes but is not limited to – macro commands; 
 formatting – spreadsheet and graphs. 

 
Outcome 2 
 
Create the computer spreadsheet. 
 
Evidence requirements 
 
2.1 Data is entered and is formatted to produce the spreadsheet required by 

the plan. 
 

Range formatting may include but is not limited to – column width, 
alignment, text, number formats. 
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2.2 Spreadsheet cell formulae, functions and processes are entered to 
produce the spreadsheet required by the plan. 

 
Range includes but is not limited to – statistical, financial, and logical 

functions; time and date calculations; sorting; absolute cell 
referencing. 

 
2.3 Macro commands are created, tested and documented according to the 

requirements of the plan. 
 
2.4 A spreadsheet template is created, named and saved in format that will 

allow the spreadsheet to be retrieved and modified. 
 
2.5 Cell ranges within the spreadsheets are graphed according to the 

requirements of the plan. 
 
2.6 Data integrity practices are demonstrated by comparing original information 

sources, audited formulae and checking totals for accuracy. 
 
2.7 The spreadsheet is printed in hard copy and checked for appropriate 

formatting, readability, legibility, and presentation, and any required 
improvements are made. 

 
2.8 The final spreadsheet is confirmed as being fit for purpose in terms of 

meeting the purpose and requirements of the organisation as outlined in 
the plan. 

 
Outcome 3 
 
Create end-user documentation for the spreadsheet. 
 
Evidence requirements 
 
3.1 A simple end-user document is created to facilitate use of the spreadsheet. 
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Exercise Files used in this book 
 
(Instructions are at the front of this book for downloading retrievable files from our web site.) 

 

Names of files 

Active Sports Garden Soils Ltd 

Albany Joinery for Charts Goodall Superannuation 

Assets Hats Income Statement 

Baxter Sports Healthy Homes Ltd 

Best Deals for Charts Holiday Options 

Box Up Supermarkets Jessie's Clothing Stores 

Brighton Winery Lifestyle Books 

Charts – Cleantec Outdoor Life - October 

Cheryl Price Invoice Premier Books 

Cleantec Recreational Magazines 

Computer Courses Sales Ranking 

Cookery and Gardening Book Sales Series 

Cool Shot Photography Spartacus – Auckland 

Costello's Product Sales Spartacus – Income Statements 

Currency Rates Spreadsheet Documents 

Cycle Stuff Sales - January Stock 

Davidsons Te Kea Trading 

Day Tripper Townsville, Jan-Mar 

Fiji Landing Apartments Wairau Office Equipment 

Flower Shop Walker and Grant Commission 

Functions  

 

Sa
m

pl
e D

oc
um

en
t



© Cherylprice.co.nz Limited SECTION 1    1 

 

 
 

Creating, Saving, Formatting and 
Editing Worksheets 

 
 

 
 

Section 1 revises some of the learning covered in the Cheryl Price book for US 2784, 
which is recommended prior learning for this unit.  It also includes new exercises 
concerning times.  Even if you have already attained US 2784, it is recommended that you 
work through this section.   

 
Learning Outcomes 
 
At the end of this section you should be able to interpret -  
 
 
 Theory 

 Understand what a spreadsheet is, how it works and why you would use 
one. 

 Spreadsheet Basics 

 Create a new worksheet 

 Enter and edit data in a worksheet 

 Save and close a workbook 

 Apply formatting to a worksheet 

 Preview and print a worksheet 

 Apply currency formats to data 

 Copy and move data using the Clipboard or mouse 

 Calculate dates and times 
 

Section 

1 

Note 
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Spreadsheets 
A spreadsheet is essentially a large working area composed of rows and columns.  Electronic 
spreadsheets are very flexible and are widely used in industry and commerce for tasks such as 
financial accounts, forecasting results, recording and comparing data, and storing valuable 
information such as personnel details.   Home users can create a budget, work out a savings 
scheme or calculate travelling expenses, while a school may use it to calculate and store 
examination results and student records.   
 
In addition to Excel 2010, other spreadsheet programs include Lotus 1-2-3, Corel Quattro Pro, 
SuperCalc. 

Advantages of Electronic Spreadsheets 
• Calculations are performed quickly and easily. 

• If data is altered, the results of calculations that use the data automatically adjust. 

• Charts can be used to visually display data, eg bar, column, pie, line. 

• Data can be manipulated, grouped and sorted into a specific order for lists, databases, etc.   

• Data within a well organised spreadsheet can be quickly located. 
 

Samples of Spreadsheets  

 

Spreadsheet/Worksheet 

The word spreadsheet is a general term for any document created by a spreadsheet program; a 
spreadsheet is referred to in Excel 2010 as a worksheet.  Both of these terms are used throughout 
this book but they refer to the same thing. 

Unit Standard 2785 uses the term spreadsheet, so this word is used to refer to learning points that 
are directly relevant to the 2785 assessment, eg planning and evaluating. 
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The Workbook 
A workbook is a file in Excel.  In each new workbook there are worksheets.  When you open a 
new workbook it contains three blank worksheets by default.  These worksheets are initially 
named Sheet1, Sheet2, Sheet3, but can be renamed. Multiple worksheets are normally used to 
display different data - for example, a company might use a worksheet for each sales branch, then 
a final worksheet which totals all sales figures from each branch and displays a summary.  Charts 
(graphs) can be created on separate chart sheets which are initially named Chart1, Chart2, etc., but 
these can also be renamed to something more descriptive.   

Sheet tabs are displayed at the bottom of the screen.  You can move from worksheet to worksheet 
by clicking on each sheet tab OR by pressing Ctrl & Page Up, or Ctrl & Page Down. If the space 
for displaying sheet tabs is not wide enough for all the tabs to be seen, the Tab Scroll buttons are 
used to scroll them. 

 

 

 

  

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

   

Active worksheet  
(displayed on screen) 

Tab Scroll 
buttons Sheet tabs 

Sydney 
Auckland 

Christchurch 

Each sheet tab can contain a breakdown of different areas, costings, 
etc within a workbook. A chart can be placed on a separate chart 
sheet, or on the worksheet containing the data being charted. 

Sydney Chart  
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4    SECTION 1 © Cherylprice.co.nz Limited 

 

Formulas 

Basic Formulas 
In an electronic spreadsheet a formula always starts with = 

This identifies that the cell contains a formula and not general data.  Cell references, numbers, and 
operators are used to create formulas.   
 

Cells and Cell References 
A cell is where a column and row meet in a spreadsheet.  A cell reference (the name of a cell) is 
made up of two parts - the column letter, eg C and the row number, eg 5.  The example below has 
the value 380 entered into cell C5. 

 
 

Operators 
Operators are used in a formula to specify mathematical operations.  There are five basic 
operations that can occur in formulas: exponentiation, multiplication, division, addition, and 
subtraction. 

Operator Symbols 

+ Addition / Division 
- Subtraction * Multiplication 
^ Exponentiation 
 

A few examples of formulas are shown below. 

  
 
The formula in cell E5 is: =B5+C5+D5  It adds up the numbers in B5, C5, and D5.   

The formula in cell F5 is: =E5*15%  It calculates the GST amount by multiplying the Total by the 
current GST rate of 15%. 

The formula in cell in G5 is: =E5/3  It calculates the average monthly sales by dividing the total in 
E5 by 3 (for the three months January, February and March).   
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© Cherylprice.co.nz Limited SECTION 1    5 

 

Formulas and Functions 

Formulas can be straightforward calculations as shown in the previous example, or more 
complicated formulas or functions. 

Functions are pre-defined calculations that are part of the Excel program. 

The basic syntax for a function is =FUNCTION NAME(arguments). The arguments are usually 
references to the cells containing the values that the function will use. 

Function names often give you an idea of what the function does, eg SUM adds up all the cells in a 
given range, while AVERAGE calculates the average amount in a given range of cells. 

It would have been simpler to use functions to calculate the Total and Average sales in the 
example on the previous page. 

The function in E5 would read:  =SUM(B5:D5) 
The function in G5 would read:  =AVERAGE(B5:D5) 
The colon (:) indicates an inclusive range of cells, in these examples, B5 through D5. 

Parentheses 

If a formula includes more than one operation (eg multiplication and subtraction), Excel follows a 
strict “order of precedence” when it carries out a calculation. Any exponentiation (using the ^ 
operator) is done first; then multiplication (*) and division (/); finally addition (+) and 
subtraction(-).  If you want to override that sequence, you must put parentheses (ie brackets) 
around that part of the formula that you want done first.  Look at the following examples and see 
how parentheses can affect the result.   

 

Example 1:   

This example follows the standard sequence.  The division is done on the last cell in the formula, 
and the result of that is added to the remaining two numbers.     

Example 2:   

In this example parentheses have been placed around the addition operations, so they are carried 
out first. The result of that is then divided by 2, giving a different result. 
 
Exercise 1 

 If you were to calculate the following sums in a worksheet taking into account the effect 
parentheses has on a calculation, what would the answers be? 

6+6+8/2 =   ..............................................  

(6+6+8)/2 =  .............................................    
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Creating a Workbook 
In the following exercise you will create a new spreadsheet in an Excel 2010 workbook. 

Exercise 2 

 Click on the Start button at the bottom left of your screen, select All Programs, Microsoft 
Office then click on Microsoft Excel 2010. 

Excel 2010 opens and a new workbook is displayed on the screen.   
 
 

Entering Cell Contents 
Data can be entered into any cell in a worksheet.  Data can be text, numbers, or formulas.  
Remember, a formula always begins with the = sign. Data can be entered into a worksheet when 
the mode indicator at the bottom left of the screen displays Ready. If this is not displayed press the 
Esc key on the keyboard until Ready appears. 
 

Text 
Text is any combination of letters, numbers, spaces, punctuation, etc.  Text data is 
automatically aligned at the left of the cell.   If the text is wider than the cell, it will 
display over the top of the adjacent cell(s).  

In the exercise that follows you will enter data into a cell. 

 Exercise 3 

1 Ensure cell A1 is selected. 

2 Type:  Car Valet Sales before GST 

When data is entered into a cell, two buttons appear to the left of the Formula Bar, the Enter 
button  and Cancel button .   

• Clicking on the Enter button  will enter the data you have just typed into the cell and 
keep the same cell selected. 

• Pressing Ctrl Enter will also enter the data and keep the same cell selected. 

• Pressing the Enter key will enter the data and move down to the next cell in the column. 

• Clicking on the Cancel button  will cancel the entry. 

• Pressing the Esc key will also cancel the entry. 

3 Press the Enter key.  

4 Type:  January-March 2011 

5 Press Enter. 
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Fill handle 

 

Entering Months using the Fill Handle 
Exercise 4 

1 Click on cell B4. 

2 Type:  January and press Ctrl Enter (to stay in cell 
B4).  

3 Position the mouse pointer on the fill handle of the 
cell, as shown at the right. 

4 Hold the left mouse button and drag to the right to cell 
D4.  Release the mouse button.  You should now have January through to March entered into 
cells B4 to D4. 

5 Click on cell E4 and type:  Total    Press Enter. 

6 Click on cell A5 and type: Full Car Valet    Press Enter.   

7 Press Ctrl Home to move to cell A1. 
 

Widening Columns 
When data is inserted into a cell it may extend beyond the width of the cell. 

• Text that is wider than the column width may be displayed across several cells - the data is 
still contained within the one cell, it just covers other cells. If the adjacent cell(s) contain their 
own data that takes precedence, the display of the data in the left cell will be truncated (ie 
appears to be cut off), although the full data remains in the cell. 

• Numbers entered that exceed the column width will display an exponential figure or will 
display ##### within the cell.  The column will widen slightly. 

 

Changing the Width of a Single Column 

Exercise 5 

1 To widen column A so that cell A5 can display all its data, 
position the mouse pointer between the column A and 
column B headers as shown at the right. 

2 Click and hold down the left mouse button.  Drag to the right to increase the column width.  
A box will indicate the width of the column.  Drag to the right until 13.00 appears as 
displayed below, then release the left mouse button. 
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Entering Data into a Spreadsheet 
By pre-selecting cells you can ensure that the data you type is entered only into those selected 
cells. 

Exercise 6 

1 Click and drag across cells B5 to D5. 

2 Type: 780    Press Enter.  This will move 
the cursor to the next cell.  

3 Type: 380    Press Enter. 

4 Type: 570    Press Enter. 

5 Turn off cell selection by clicking on another cell or moving to another cell using one of the 
arrow keys. 

If you have made an error, select the incorrect cell and amend it using the editing techniques 
described below. 
 

Editing Within a Cell 
Exercise 7 

Cell entries can be altered directly within the cell.  You will now change the entry in cell A2 to 
read January-March 2012. 

1 Double click on cell A2 (OR with cell A2, selected press F2).  Press the End key to move to 
the end of the text. (When you double click on a cell the insertion point is positioned where 
you double clicked.) 

2 Press the Backspace key once, then type: 2  

3 Click on the Enter button  OR press Ctrl Enter. 
 

Deleting 
To delete the contents of a cell, click on the cell and press the Delete key.  To delete the contents 
of a range of cells, select the cells then press the Delete key. 

Exercise 8 

1 Click on cell A5.  

2 Press the Delete key. 

The Delete key will remove only the contents of the cell. 

For other options, click on  in the Editing group of the Home tab. You can select the most 
appropriate action from: 

Clear All  clears all formats, cell contents and notes 
Clear Formats  clears formatting eg cell alignments, font styles, etc 
Clear Contents  clears only the cell contents 
Clear Comments  clears any comments attached to the cell(s) 
Clear Hyperlinks clears hyperlinks from the selected cell(s) 
  

Sa
m

pl
e D

oc
um

en
t



© Cherylprice.co.nz Limited SECTION 1    9 

 

Undo 
If you make an error when editing, the Undo feature allows you 
to cancel your last action.   

Exercise 9 

 Click on the Undo button  on the Quick Access Toolbar. This will redisplay the text Full 
Car Valet in cell A5. 

Clicking on the Undo drop-down arrow displays a list of previous actions, from which you 
can select an action to undo. The most recent action will be at the top of the list. Selecting an 
action will undo it and any other actions above it in the list. 

 

Redo 
The Redo button is used to reverse the Undo command.  (By clicking on the Redo drop-down 
arrow  you can see a list of “redo” actions, used in the same way as for Undo.) 

Exercise 10 

1 Click on the Redo button  on the Quick Access Toolbar to redo the delete. 

2 Click on Undo again so that the text Full Car Valet reappears in cell A5. 
 

Applying Bold Text and Totalling a Row 
Exercise 11 

1 Press Ctrl Home to move to cell A1. With the cell selected click on the Bold button  on 
the ribbon.  (You will learn more about formatting on page 10.) 

2 Click on cell E5.  Click on  twice.  This will create a Sum function that will 
calculate the total sales.  (You will learn more about functions later in this book).   

On your screen the AutoSum button may be displayed without the actual name, ie    

 
Saving the Workbook 
 
Exercise 12 

1 Click on the Save button  on the Quick Access Toolbar. Ensure the Save in: box displays 
the default folder (My Documents\US2785 v6 Excel 2010 Book Exercise Files). 

2 With Book1 selected in the File name: box type: Car Valet  

3 Click on . 

The workbook file has been saved into your working folder.  For the exercises in this book 
continue to save and open all workbook files to/from the default folder. 
 

Closing a Workbook 
Exercise 13 

 Click on the Close Window button . Before the workbook is closed, you may be asked to 
save any changes made - if this happens click on Yes. 

  

Ctrl S 

Ctrl Y 

Ctrl Z 

Alt F4 

Note 
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Tips 

 

Fonts 
A font is an individual typeface design. Changing the font type and size allows you to emphasise 
areas in a worksheet.   
 
 

 
 
 

 
In addition to using the Formatting buttons shown above, options can be changed in the Format 
Cells dialog box, where fonts and formatting changes can be previewed before applying them to 
cells.  Ensure fonts used fit the purpose and style of the worksheet. 
 

Format Cells, Font tab Dialog Box 
a) Select the cells to be formatted. 

b) Right-click on the selection and choose 
.  The Format Cells dialog box 

is displayed as shown at the right. 

(Alternatively, click on  in the Cells 
group on the Home tab, and choose 

.) 

c) Click on the Font tab. 

d) Select the font, font style, size and any other 
formatting required. 

e) Click on OK. 
 

Mini Toolbar 
 

When you right click on selected cells the Mini Toolbar will be 
displayed, as shown at the right.  Formatting options can be 
selected from this toolbar.  

 
 
 
• In Excel 2010 individual words or characters in a cell can contain different formatting, eg 

Sale Prices - December 2011 

• To alter the default font for every workbook, click on the  tab, then on .  
Select options from the Use this font:  and Font size:   shown below.  

• Click on OK. 
 

  

Ctrl 1 

Font Font Size 

Bold 
Italic 

Underline 

Font color 

Align Left 
Center 

Align Right 
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Formatting your Worksheet 
Exercise 14 

1 Click on the File tab, then on Open.   

2 Double click on the workbook called Wairau Office Equipment.   

3 Right-click on cell A1.  A drop down menu appears as shown 
at the right.  

4 Choose .  The Format Cells dialog is displayed. 
Click on the Font tab. 

5 Apply the font called Impact and change the font size to 24 pt.   

6 Click on Bold in the Font style: box then click on OK. 

Use the Formatting buttons on the ribbon to change fonts and 
effects as follows. 

7 Change the font for the subtitle in cell A2 to Arial 12 pt. 

8 Click on cell A5.  Click on the Bold button  and the Italic button . 

9 Format cells A10 and A11 to italics. 

10 Select cells A13 to D13.  Click on the Bold button. 

11 Apply bold to cell A26. 

The Formatting buttons on the ribbon are a quick and efficient method of applying fonts and 
formats. Features such as Bold or Italic can be turned on or off by clicking on the appropriate 
button.  Alternatively, the Mini Toolbar can be used. 

12 Widen column A until all the text in cells A10 to A24 are displayed. 

13 Save the workbook. 
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Borders and Patterns 

Borders Button 
Borders (lines) can be inserted into a worksheet using the Borders button  in the Front group 
on the Home tab.  On the Borders button  you can click on the down-arrow and select the style of 
border required.  A line style and colour can also be applied using the buttons displayed under the 
Draw Border section in the Borders drop down menu as shown below. 
 

 
 
 

Format Cells, Border tab Dialog Box 
a) Select the cells required and right-click on the selection. 

b) Choose .  Click on  
the Border tab in the Format Cells dialog box. 

c) Select the line style and line colour required  
in the Line section. 

d) Click on a preset button OR click on a Border  
button to apply a border.  To remove a border  
click on the relevant Border button to turn off  
the border OR select None. 

e) Click on OK. 
 

Removing Borders 
Borders can be removed as follows. 

• Select the cells with the border style applied.  Click on the  of the Borders button and 
choose . 

• Select the cells with the border style applied and right click on the selection.  Choose 
.  Click on the Border tab in Format Cells.  Click on None.  Click on OK. 

• Select the cells with the border style applied.  Choose  in the Editing group on the 
Home tab. Choose  (remember this will also clear number formats and 
alignments). 

• Click on the  of the Borders button and choose .  This turns the mouse pointer 
into an eraser, so lines can now be removed by clicking on them with the mouse. 
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